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Menus
For additional information in any area of interest, click on the appropriate subject below:

Edit Menu 
File Menu 
Options Menu 
The Help Menu 
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Overview
32Bit Integrated Publishing
Calamus for Windows NT was designed to fulfill the need for a true 32bit highend desktop 
publishing application for the Windows NT market. Calamus offers a new concept in design 
and function, providing greater creative and production control than other publishing 
systems. 

For additional information in any area of interest, click on the appropriate text below:

Modular Architecture 
User Interface

Key Binding 
Command Groups
Coordinate Display
Context-sensitive Help
Short Cuts
Character Set Table
Resident Clipboard



File Menu
Create, Open or Merge multiple documents even if they contain different page formats. 

Abandon Changes allows you to abandon all changes made to a document since it was last 
saved and then automatically reloads that saved version. 

Other options include; Save, Save As, Save All, Close Document and Print Document. For 
more information on printing using Calamus, see Output.

Modules can be loaded or deleted at will, allowing Calamus to be configured to specific 
requirements. Modules allow Calamus to perform certain functions normally associated with 
external programs. Dozens of modules are available.

Calamus is supplied with a large number of import/export drivers for both graphics and text. 
These too can be loaded or deleted as needed.



Options Menu
Help messages are optional; they can be toggled on and off.

Calamus offers both Physical and Virtual copying of frames. Physical copies are independant 
copies of the original frame. There is a relationship between Virtual copies. A change in the 
contents of one, and Calamus will ask if you would like to make the same change to the 
other(s). The number of copies, as well as the horizontal and vertical offset of each copy, 
can be specified.

Calamus supports Drag and Drop.

Statistics reports elapsed time of current session, number of pages, page number of last 
page used, number of current users, free memory (physical and virtual) and percentage of 
memory in use.

Reformat Document offers powerful reformat facilities for footnotes, indexes, chapter and 
page references, even time and date references.

The Document Parameters function can be used to save, lock or delete items such as: 
unused colors, fonts, text styles, master pages, planes and pages.

The Macro Recorder can be used to assign a series of mouse movements and keyboard 
clicks to a Key Binding.

The various folders and subdirectories used by Calamus are established using the Set 
System Paths function.

Miscellaneous Settings, controls whether a document is saved with or without backup, as 
well as the time between automatic saves: 1 hr, 30 min, 15 min, 5 min or 1 min. Whether 
dialog boxes appear at the topleft corner of the screen, in the center, or at the cursor 
position can also be specified.



Edit Menu
The Edit menu is used to access the Windows NT Clipboard functions.



Window Menu
Elements of the Calamus userinterface can be turned on or off using functions available in 
the Window menu.



The Help Menu
This menu allows access to the online help built into Calamus. 



Output
Calamus is compatible with all output devices that are supported by Windows NT including 
PostScript devices. This includes highperformance typesetters and RIPs such as those from 
Linotype and Agfa. Calamus, through its unique SoftRipping technology, can also output to 
PostScript and nonPostScript devices at high resolutions. Remote network printing and 
background printing are also supported. Calamus has optimized drivers for a wide range of 
highend output devices.

Print parameters include: 

Number of copies including collation 
Document scaling including fit to size
Sort in ascending or descending order 
Print range
Printing of left, right pages or both in a Facingpage document 
Tiling
Landscape or portrait orientation
Inverted or mirrored options
Support for different paper trays

Fast draft copies can be printed by using Windows printers drivers with no Calamus 
SoftRipping.

When outputting to Postscript devices using SoftRipping, Truetype fonts may be either 
rendered on output, downloaded or substituted.

The Color Separation module allows for the printing of various color layers as well as spot 
colors. Overprinting and knockouts are also supported by the Color Separation module.



Page Module

The Page module allows you to set page format for your document, select from 8 predefined 
standard sizes or enter your own custom size. Pages can be oriented to either portrait or 
landscape and can be set up as either single or facingpages. When working with facing-
pages, both pages can be edited when displayed on screen.

Page numbering in any of 5 different numbering styles can be used.

The Page Layout Setting Dialog Box allows for the accurate placement of crop and 
registration marks, color balancing fields and document labels. The Overlap option 
compensates for gutters.

Set Units of Measure allows choice from metric, imperial, cicero, pica and points as your 
basic unit of measurement within Calamus. 

Pages can be saved to disk, loaded from disk, inserted, moved, copied and deleted. Master 
pages are pages that can be used as templates for document pages. Infinite master pages 
can be used in a document. Master Pages can be saved, loaded from disk, assigned, copied, 
and deleted.



Frame Module

The most basic elements within Calamus are frames. All data is contained within frames. 

Frame Types

Frames can be created, modified, grouped, ungrouped, protected, sized proportionally, 
copied, placed in the foreground or background and deleted.

The Frame module also is the gateway to special functions that are associated with the 
different frame types.

Text Frame Special Functions
Raster Graphic Frame Special Function
Vector Graphic Frame Special Function

In the Miscellaneous Functions command group, the Write mode for any individual frame can
be specified. The choices are transparent, opaque, and inverse. Frames can also be mirrored
horizontally or vertically, and rotated to any angle. Frames can even be named.

To aid in the design and development of documents, Calamus offers extensive design tools 
such as userdefinable guidelines, grids, magnetic frames, column and row settings. Calamus
also has the ability to snap to these guidelines and grids horizontally and vertically. 
Guidelines can be placed manually or by using the coordinate display for exact positioning.

Under the Frame Display command group, any type of frame can be turned on or off to 
speed up refresh times. Frame borders can be made invisible to give a more accurate 
representation of what the document will look like. Guidelines and grid can also be turned on
or off. Other design tools include a long cross hair and layout ruler.



Text Module

The Text module is used to enter text into a text frame and also provides tools to format 
text. 

The following tools are provided in the Text module:

Text Module Tools

Ruler Settings Dialog Box

Calamus supports Drag & Drop when working with text. Style information can also be 
preserved when using this feature. Although text can be entered directly into the layout 
window,    the Text Editor is better suited for entering a large amount of text. The Text Editor 
is accessed through the Text module.



Text Editor
Calamus has a builtin text editor which is very useful for entering large tracts of text. The 
Text Editor also contains a wide range of the most popular texthandling functions. 

Text Editor Dialog Box

These functions include:

Text Handling Functions

Block operations include:

Block Operation Functions

You are also able to specify how these above control codes will appear in the Text Editor. 
These control codes are also accessible via the right mouse button. Text from the Text Editor 
can replace, be added or merge with text existing in the text frame.



Text Style Module

This module offers control over the various styles that can be applied to text within Calamus.
Calamus is compatible with over 2000 typefaces from type foundries such as ITC, URW, 
Berthold, Compugraphic and Linotronic, as well, Calamus is also compatible with TrueType 
Fonts. All font handling including replacing a font is done through this module. 

Text can be manipulated in the following ways:

Text Manipulation Options

Text effects include: 

Text Effect Options

Calamus organizes any text style used in a document into text style lists. These lists can be 
modified, deleted, loaded from, or saved to disk.



Text Import and Export Drivers
Calamus currently supports the following file format drivers:

ASCII 
Write for Windows 3.1/NT format
WordPerfect 5.0, 5.1
Word for Windows 2.0
Rich Text Format 1.0
Lotus AMI Pro 3.0
Calamus Text Format
Calamus Text Document

Some drivers allow the selection of text font and point size on import.



Line Module

Lines are an important design element in desktop publishing and Calamus has a specific 
module for creating lines. 

These options include:

Lines can use any color or fill pattern from the color table
Line types (18 predefined line types)
Line ends (3 predefined line ends)
Line styles (8 predefined line styles)
Line thicknesses (8 predefined line thicknesses plus input field)
A shadow can be added to lines with full control of the shadow's color, direction and offset



Raster Area Module

Raster areas are another important design element in desktop publishing. The Raster Area 
module is used to create and modify raster areas. 

Raster areas can be manipulated in the following ways:

Raster areas can be any color or fill pattern from the color table
Raster shapes (15 predefined shapes)
If shape contains corner attributes, the size of the corner can be set
Border color and fill pattern can be established
Border weight (8 predefined thicknesses plus input field)
Border style (8 predefined styles)
A shadow can be added to raster areas with full control of the shadow's color, direction and 
offset

Raster Shape Illustration



Vector Editor Module

Calamus contains a powerful vector editor that allows vector graphics to be created or 
modified within Calamus. This eliminates the need to leave the program to manipulate 
vector graphics. 

Functions in the Vector Editor Module include:

Vector Editor Module Functions

The Vector Editor Module offers two views, full page or a userdefined zoom, to aid in the 
development of vector objects. 

The paths that make up vector objects can be modified using the following tools:

Vector Editor Tools

The Vector Editor Module also contains functions found in the Raster Area Module. The 15 
predefined shapes can be used as vector objects and the thickness, color and style of the 
border can be established.

The contents of Line, Raster Area and Text frames can be converted into vector objects for 
manipulation in the Vector Editor Module. Raster Graphics frames can also be loaded into 
the Vector Editor Module to be used as a background image for tracing purposes.



Blend Module

With the Blend Module, both linear and circular blends can be created. 

The definable settings include:

Blend colors (start, transition and end)
Size and resolution
Unidirectional, bidirectional and Tricolor blends
Reverse direction
Angle of blend

The Blend Module also has a preview mode.



Rotation Module

The Rotation Module allows the rotation of Raster Graphics in 0.01 degree increments and 
has masking and antialiasing capabilities for smoother handling of rotated bitmaps.



Brush Module

The Brush Module is a handy module for creating and editing bitmap (raster) graphics. 

It includes:

20 styles including a variable size
Undo Function

The Brush Module will use any color or fill pattern available in the color table or sampled 
from an image.



Graphic Import Drivers
For a complete list of import drivers, click on the appropriate item of interest,

Bitmap: 
Vector 



Bitmap
TIFF 6.0    
GIF 89a 
Targa 2.0 
BMP
PCX 
GEM Image    
MacPaint 
CRD Calamus Raster Document 
PCD Photo CD
JPEG
Scitex CT



Vector
CVG 1.1 (Calamus Vector Graphic)
WMF (Windows Metafile) 
CVD (Calamus Vector Document) 
HPGL 



EPS Handler Module

The EPS Handling module will import EPS files and contains an option to resize a graphic to 
its ideal size.



OLE Module

Calamus supports the Object Linking Embedding feature of Windows NT. Frames within a 
Calamus document can be linked to other applications in a client/server relationship. This 
module also has the ability to convert data from a server application into a bitmap or to 
delete links to the server application.



System Parameters Module

The System Parameters module is used to modify a number of internal features in Calamus 
including:

Save font directory on/off
Enable/disable Tool Tips
System paths can be defined as relative or absolute
Set monitor resolution
Choose between Calamus or Windows file selectors
Set vector output buffer size
Set date and time format



Linearity Module

The Linearity module is used to optimize color output to printers. A control line is established
for each color plane. Control lines can be defined using Bézier, freehand or Gamma curves. 
The Linearity Module includes a clipboard. Control lines can be be saved to or loaded from 
disk.

Color Correction Dialog Box



Color List Converter Module
This module automatically converts all free colors in a document to list colors upon 
execution.



Color Support
Calamus color tables support over 16 million colors. Colors can be defined using the RGB, 
CYM, CYMK, K or IHS color systems. Color can also be defined using standardized color 
models such as; Focoltone, HKS, Europalette, Truematch and Pantone. A total of 32 pre-
defined fill patterns are included. Color tables can be saved and reloaded for future use.

Color List Converter Module 
Color Separation Module 



Color Separation Module

The Color Separation module is essential for color printing. It uses control lines to define 
both Under Color Removal (UCR) and Gray Color removal (GCR) for process colors as well as 
spot colors. Control lines can be modified using Bézier, freehand or Gamma curves. The 
Color Separation Module contains a clipboard and control lines can be saved and loaded for 
future use. Black overprint allows you to keep color planes under black elements (will not 
create knockout). 



Raster Generator Module

The Raster Generator module controls raster settings, an important element in the image-
processing stage of desktop publishing. 

The various settings for rasters include:

Frame, page or document level
Settings for process and spot colors
Raster angle
Raster width
Raster shape (triangle, circle or square)
Elliptical bias
Output resolution

The Raster Generator module includes load/save functions.

Raster Settings Dialog Box 



StarScreening Module

Frequency Modulated screening can be used for output using the StarScreening Module. This
module handles output up to 750 dpi. StarScreening can be applied to all 4 color planes or 
each color individually. 



Toolbox Module

The Toolbox module is a layout utility which allows the alignment of frames and the 
conversion of frames from one type to another. With the first command area, frames can be:

Top aligned
Bottom aligned
Left aligned
Right aligned
Aligned at the horizontal center
Aligned at the vertical center
Concentric aligned
Moved to master page
Moved forward
Moved backwards
Make Invisible
Turned off for printing purposes

With the second command area frames can be:

Converted to another frame type
Converted to a bitmapped graphic



Scanner Module

This module allows the loading of scanner drivers for scanning of images directly into 
Calamus. Monochrome, grayscale and color scanning is supported, with preview scanning 
mode. Multiple formats and resolutions are supported as is reflective and transparency 
scanning (hardware dependent). Drivers currently available include: AGFA Arcus, Epson 
GT8000 and Canon CLC10.



Mount Module

This module allows the collation of a document into a booklet and will work with multiples of 
pages that fit exactly an output device's capabilities. For example you can print two half 
pages on a lettersized page.

Many optional modules and drivers are already available with more being added on a regular
basis. Please contact DMC directly for up to date information.



Preview Module

The Preview module allows you to view a complete page, WYSIWYG, using all correct writing 
modes. 



Page Tool Module

Page Tool allows you to view and manipulate all pages in a document in thumbnail format.    
Move, insert or delete pages. Display selected frame types only. The size of the thumbnail is 
userdefinable. Pick the horizontal and vertical pixels as well as the number of columns you 
wish to view. 

Page Tool Illustration



Mask Module

The Mask Module is a powerful graphics tool that allows the creation of dynamic masking 
effects within Calamus. 

Cropping selected areas of a graphic can be achieved with any element in Calamus. Use the 
Vector Module to trace objects in bitmaps, fill type with blends or images. Masking with 
vector based objects creates an edge that is resolution independant. The edge of the mask 
will cut through single pixels allowing for a clean look to the composite image. 

The example below demonstrates some of the effects that can be achieved using this 
module.

Mask Module Illustration



Hardware Recommendations
For DEC Alpha AXP
DEC Alpha PC 
16 Mb RAM or more
300 Mb hard drive or more
CDROM

For Intel Based platforms 
I486/Pentium CPU at 50Mhz or faster 
16 Mb of RAM or more
300 Mb hard drive or more
CDROM

For ARC R4000 based platforms 
R4000 RISC CPU
16 Mb of RAM or more
300 Mb hard drive or more
CDROM

For IBM PowerPC
PowerPC RISC CPU 
16 Mb of RAM or more
300 Mb hard drive or more
CDROM

Please consult the most recent Microsoft Windows NT hardware compatibility list for a list of 
tested hardware, available on the Windows NT CD. 

Specifications subject to change without notice.

I486 and Pentium are registered trademarks of Intel Corp. Inc. R4000 and MIPS are 
trademarks of MIPS Computer Systems, Inc. Windows NT, Word for Windows and OLE & DDE 
are registered trademarks of Microsoft Corporation Inc. TrueType is a registered trademark of
Apple Computer Inc. Calamus, SoftRipping and StarScreening are registered trademarks of 
DMC. PostScript and Adobe Type Manager are registered trademarks of Adobe Systems Inc. 
Alpha, AXP are registered trademarks of Digital Equipment Corporation Inc. Agfa and Agfa 
Arcus are registered trademarks of Agfa Gevaert B.V. IBM is a registered trademark of 
International Business Machines Corp. PowerPC is a registered trademark of Motorola.



Modular Architecture

The open architecture of Calamus enables you to add and remove features as required. It 
also allows for new capabilities to be seamlessly incorporated as they are developed.

Calamus employs a unique modular architecture. The package is built around modules, each
addressing a specific function. This allows the user to customize the working environment by
loading only those modules that are required for the work session. These modules are 
controlled through Calamus' Graphical User Interface.    



User Interface
The user interface is made up of the following elements:

The Module Row provides both visual representation and easy access to the various modules
that make up the Calamus Integrated Publishing solution. Calamus can handle up to 42 
modules at one time.

The Iconbar provides access to modules that do not have standard module command 
groups.

The Toolbar offers view modes including full page, 1:1 view (Actual Size), and custom zoom 
from 0.001% to 999,999.99%. This mode also includes a 1:1 printer (based on the dpi of the 
installed printer). The magnifying glass can be used to zoom into any area of the document.

The Toolbar also handles page control. Arrow keys can be used to step through a document 
or the required page number can be entered directly. Left and right pages can be assigned 
and Calamus has the ability to edit facing pages while both pages are displayed on screen.

The Module Row, the Toolbar and the module command group area can be placed anywhere 
on the screen to customize the user interface.

An integral part of the user interface is its ability to use either the standard Windows file 
selector or the Calamus File Selector. The Calamus File Selector allows you to view files using
a file mask, sort files by name, date, size, type, unsort or delete files, create folders, rename,
copy or move files, and select the appropriate drive letter button for the active drive. 

Support is also provided for NTFS volumes (long filenames, etc.), full network support and 
direct connection to remote network drives.



Key Binding
All functions within Calamus can be assigned a Key Binding. When the cursor passes over a 
function these userdefinable keyboard equivalents are displayed in the Toolbar.



Command Groups
Functions for the various modules are accessed through the Command group area. Functions
within these command groups are arranged in a logical hierarchical fashion.



Coordinate Display
The coordinate display indicates the cursor position. When a frame is activated in Layout 
mode, the coordinates of the frame, X and Y are displayed. Direct editing of these 
coordinates is allowed. The coordinate display has an accuracy of 5 decimal places, allowing 
for the accurate sizing and placement of frames. Expression parsing can also be used in the 
coordinate display.



Context-sensitive Help
To minimize the learning curve, Calamus has builtin context sensitive Help. When passing 
the cursor over any icon or function a help message will appear in the bottomleft corner of 
your screen. Calamus also uses Tool Tips.



Short Cuts
In addition to the key bindings, Calamus makes use of other shortcut keys to aid in the 
creation of documents. For example, the Delete key deletes the currently selected frame; 
the ControlShiftAlternate key combination halts screen refresh.



Character Set Table
The full character set table is available in all input fields and when inputting text using the 
ASCII input method.



Resident Clipboard
Our resident clipboard is independent of documents, allowing for the cutting, copying, 
deleting and pasting of elements between multiple documents. The clipboard will accept any
Calamus element (frames, text, text rulers) and is limited only by memory. 

Full support for the Windows NT Clipboard functions, OLE and DDE (Dynamic Data Exchange)
is built into the program.



Screenshot Illustration







Page Layout Settings Dialog Box



Frame Types
Calamus supports the following type of frames:

Text frames; regular, index and footnote 
Line frames
Raster Graphic frames for bitmap oriented graphics
Raster Area frames
Vector Graphic frames for object oriented graphics 
Uniframes for OLE, EPS and special object data.
Tiling frames; portrait, landscape and userdefined



Text Frame Special Functions
The special functions for Text frames include:

Frame type (regular, index or footnote)
Index numbering (5 styles) 
Chapter numbering (7 levels 5 styles) 
Text piping controls
Text flow around object parameters including irregular objects



Raster Graphic Frame Special Function
The special functions for Raster Graphic frames include:

Image type (monochrome, grayscale, or color)
Set control line using Bézier, Freehand or gamma 
Optimization for screen or printer
Optimize to the nearest geometric multiple 
Center image in frame
Make the size of the image independent of frame size
Crop image

Images can also be converted from one type to another within this command area.



Vector Graphic Frame Special Function
There is only one special function for Vector Graphic frames and that is the ability to 
optimize the size of the object.



Ruler Settings Dialog Box



Text Editor Dialog Box



Raster Shape Illustration



Color Correction Dialog Box



Raster Settings Dialog Box



Vector Editor Module Functions
Group or ungroup objects
Shrink frame to object size
Join objects
Distort objects
Resize proportionally
Copy objects
Place object in background or foreground
Delete objects



Vector Editor Tools
Select/move point
Delete point
Add point
Reverse path direction
Close and round path
Join paths
Convert line to Bézier curve and vice versa
Separate paths
Show tangents
Cut path from object
Copy path
Delete path



Text Manipulation Options
Fonts can be sized from 0.001 to 9999.0 points
14 userdefinable settings
Font size can be based on Em, Versal or Designer height
Graphic representation of font
Check text style
Proportional spacing
Automatic kerning
Numeric table
Text right to left
Character spacing
Word spacing
Underline in front of text



Text Effect Options
Normal
Underlined including weight, offset, overhang and color
Outlined including fill color, outline color and weight and transparency
Shadowed including color and horizontal/vertical offset
Superscript and subscript
Compressed via percentage
Skewed including skew angle 



Text Handling Functions
Undo function 
Reformat text
Search/Replace text and text style 
Goto line
Bookmark functions
Insert text styles and text rulers
Insert Control Codes
Page number
Following page number
Date and time 
Chapter number
Comment
Footnote entry
Reference from previous/to next page
Index entry
Paragraph end 
Manual kerning
Forced piping
Variable hard space
Drop caps



Block Operation Functions
Copy
Paste
Delete
Cut
Convert to upper or lower case



Text Module Tools
Insert page number, both current and next - Insert chapter number
Insert time and date - Insert reference to following/previous page
Footnote/index entry    - Manual kerning - Insert text style
Forced piping - Delete text block    - Drop caps
Key bindings for special characters - anchor frame to text
Spellchecker and hyphenation table - Character set overview
Tabs and leader tabs    - Left and right margins and indents
Left/right/full justification and centered text -Line and paragraph spacing
Absolute and relative spacing - Word spacing
Vertical text alignment - Insert text ruler
Text macros



Page Tool Illustration



Mask Module Illustration

 




